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Overview 

Introduction 

 
The Infrastructure Project Database provides online high-level infrastructure tracking, 
including: 

• the cabinet and public sector procurement body responsible for the project 

• budget 

• milestones 

• contractor details, and  

• contacts. 

You can use this database to: 

• create new projects 

• search for and edit existing projects 

• add and edit contractor records, and 

• add and edit project contact details. 

In addition, Administrators can: 

• set and overall annual budget for each cabinet to help track spend against budget 

• assign specific user access rights on a project by project basis, and 

• export financial data on a project by project and year by year basis. 



 

Infrastructure Projects Database 

 

 

Version 1.0  September 2010 Page 6

 

User Roles 

The following user roles exist within the system: 

• Departmental User – Access to projects within their home public sector procurement 
body. Access to all functions with the exception of Administration menu and cabinet 
finance options. 

• Departmental Head – Full access to all projects within their Scottish Government 
Director General (SGDG) Responsibility. Access to Project Access and Cabinet 
Budgets within Administration menu. 

• Administrator – Full access to all projects and functionality. 

Navigation 

When you login, you will be presented with the system home page. From here you can 
access each area using the left hand menu. You can choose whether you want to hide or 
show this using the Hide/Show Navigation buttons at the top of the navigation. 



 

Infrastructure Projects Database 

 

 

Version 1.0  September 2010 Page 7

 

Logging in 

User ID and password 

 
When you successfully register for an Infrastructure Project account you will receive an email 
from the service desk containing your personal login details, namely: 

• your unique User ID  

• a system-generated password 

• details of your security rights 

• a hyperlink to Infrastructure Project on the Government Secure Intranet (GSI) or 
Secure Internet. 

You may want to bookmark the Infrastructure Project Login screen in your browser by adding 
the URL to your favourites.  

The Infrastructure Project login password field is case-sensitive, so make sure you type any 
letters exactly as they are displayed in the email.  DO NOT opt for the browser to remember 
the password. 

If you are a first-time Infrastructure Project user you will be automatically directed to a page 
where you can change your password. This ensures maximum security so that no-one, 
including service desk, can use your details to login.  

You will also be prompted to change your password every 90 days, or you can manually 
change it at any time. 
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Unsuccessful login 

If you cannot login because your User ID/password combination has not been found, contact 
the Service Desk at ServiceDesk@ogc.gsi.gov.uk.  

DO NOT disclose your password to the service desk, only tell them your Infrastructure 
Project User ID. 

Forgotten password 

If you forget your password or you believe that it has been compromised, send an email to 
ServiceDesk@ogc.gsi.gov.uk explaining what has happened. 

DO NOT disclose your password to the service desk, only tell them your Infrastructure 
Project User ID. 

Locked account 

If your account has been locked out, usually after three unsuccessful login attempts, you will 
see the screen below.  

 
Make sure you enter your User ID and email address correctly and then click the Reset 
Password button. This will send a message to the service desk, who will reset your 
password. You will receive notification of the changed password details via email. 
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Changing your password 

When you login to the Infrastructure Project for the first time you will automatically be 
directed to the change password screen, shown below. 

 
You can also choose to change your password whenever you login by selecting the Change 
password after login check box on the login screen. 

If your password change is successful, a confirmation message will display. The next time 
you login to the Infrastructure Project you will need to use your new password. 

Unsuccessful password change 

If your password change is unsuccessful, red validation text will display telling you what 
needs to be changed or completed. 

Logging out 

For security reasons it is recommended that you always manually log out of the Infrastructure 
Project rather than just closing the browser down.  

In the top right corner of each Infrastructure Project screen is a blue log out link. Use this to 
manually end your session and return to the login screen.  

If you remain inactive for a period of time while logged into the Infrastructure Project you will 
be automatically logged out and prompted to login again. 
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Create New Project 

Overview 

The Create New Project process has six steps, each with their own tab on the screen: 

• Project 

• Milestones 

• Financial 

• Contracts 

• Contact 

• Review. 

On each tab make sure you complete all mandatory fields – these are marked with a red 
asterisk *. You will be unable to progress to the next stage unless you provide all mandatory 
information. 

If you need to know more details about the information needed for any of the fields, click the 
 information button next to it – this will open an explanatory pop-up. 
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Project screen 

When you select New Project from the left navigation you will see the first of the tabs: 

  
Use this tab to input details about: 

• The project 

• Organisation 

• Finance overview 

• Other details 

• Additional information 

• Project Officers, and 

• Location. 

When you have completed all the fields, click Next to proceed to the Milestones tab. 
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Milestones 

     
There are six types of milestones: 

• Gateway Assessment Milestones 

• Gateway Review  

• Key Stage Review  

• Project Milestones 

• Planning 

• Post Project/Post Occupancy Evaluation 
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To add a Milestone: 

1. Select the Yes radio button at the top of the Milestone group. 

2. If necessary, select a relevant Milestone type from the drop-down menu. 

3. Complete any date, status and value information. 

4. Click ADD. 

With the exception of Project Milestones, which are mandatory for all projects, you will have 
to confirm whether or not each milestone group applies to the project. If any milestones do 
not, select the No radio button and provide a reason for this. 

You can apply milestones for each group to a project more than once, apart from Gateway 
Assessment. A milestone must be either cancelled or have been reached before you can 
apply it again. 

You can add up to 15 milestones to any one group. 

The system tracks changes to milestone dates and the application of milestone groups using 
a change log. 

Note that you cannot delete milestones – you have to change their status to Cancelled and 
create a new milestone. 

When you have completed all the relevant Milestone details, click Next to proceed to the 
Financial tab. 
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Financial 

 
This tab lets you set up and maintain Capital Finance and Estimated Revenue figures. 

To add Capital Finance figures: 

1. Set a base year from the drop-down menu. 

2. Click the Add Year button and select a year from the drop-down menu. 

3. Complete all mandatory and any other relevant fields. 

4. Click SAVE. 

5. Repeat this process to add figures for further years. 

If you want to change existing capital finance figures using the EDIT function, you will have to 
input a reason for the change. The date of this change, the reason, the field(s) changes, and 
the new amount will be saved to an audit log for reporting purposes. 

You can export the financial information as an Excel spreadsheet by clicking the Export link 
at the bottom of this tab. 

Click Next to save the data and proceed to the Contracts tab. 
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Contracts 

 
This tab lets you add contract details to the project. 

Note that you can add numbers of expressions of interest and companies to the Milestones 
section by clicking the relevant EDIT and SAVE buttons. 

When you have completed all the relevant fields, click Next to proceed to the Contacts tab. 
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Contacts 

 
This tab lets you add a contact for the project. 

You can either select an existing contact using the drop-down menu or click Create new 
contact to add details for a new contact. 

Click Next to proceed to the Review tab. 
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Review 

 
This tab lets you review all the details you have input for the project on one screen. 

You can expand or collapse the details you have entered under each tab using the + and - 
buttons.  When you have expanded a tab, you can also edit the existing details using the 
Edit button that displays. 
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Search Project 

 
Clicking Search Project in the left navigation lets you search for projects using a three step 
process. 

• Search – the tabbed screen shown above 

• Select – shows all relevant matches to your search criteria 

• View – from this tab you can view and amend details for individual projects 

To run a search, enter details in as many, or as few, fields as is relevant and click Search 
Projects. This will filter the results according to the fields you have selected, so if you don’t 
enter any search criteria in any of the fields, the search will return all projects in the 
database.  
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When you click Search, the Select tab for the Search displays: 

 
The results are displayed alphabetically, according to their Project Name. If numbers are 
displayed at the bottom of the results list, this means there are further screens of results – 
click on the numbers to display these. 

Click on the  Report folder icon to view any Capital Forecasting reports generated for this 
project. 

Click Export to save the search results, complete with all their details, to an Excel 
spreadsheet. 
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Click the View Details button next to any search result to go to the View tab: 

 
You can expand or collapse the details entered under each tab using the + and - buttons.  
When you have expanded a tab, you can also edit the existing details using the Edit button 
that will display. 

However, the Audit Log tab is not editable, but displays a read-only record of the date and 
details of all amendments to the project. 

Click Back to Search Results to return to the Select tab. 
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Contractors 

 
You can search, edit and add Contractor details by clicking Contractors in the left 
navigation.  These companies and consortiums will be used within the Milestone screen – 
see earlier. 

As with the Search Project screen, you can complete as many of the search criteria as is 
relevant. Entering no search criteria in any of the fields will display all Contractors in the 
database. 

When you click Search, the results display in a table below the Search fields: 

 
Click the Select button to view a Contractor’s details. If you want to amend any of these 
details, do this in the screen that displays (see the following page) then click the Save & 
Continue button. 
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Adding a New Contractor 

Click the Add New button to add a new Contractor to the database: 

 
Complete all the mandatory and relevant fields and click the Save & Continue button. 

If you select Consortium from the Bidder Type drop-down menu, a further Search screen 
displays, enabling you to search for Contractors to add to the Consortium.  

When you click Search on this screen, a further Search Results panel displays beneath the 
Search fields: 

 
Click Select to add the Contractors to the Consortium. Another panel now displays, showing 
the names of all Consortium members: 

 
Click the  button next to any Contractor to remove it from the Consortium. 
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Contacts 

 
You can view and edit Contact details by clicking Contacts in the left navigation.   

Click Select to display the Contact’s details. If you want to edit any details for the Contact, 
click Edit on the screen that displays, edit any details and click Save. 

Click Create new contact to add details for a new contact. 
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